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Create a New Object Type

To create a new object type:
1. Click the @ icon in the top bar > Object Types in the Data Model section.
2. Click Create Object Type.
3. Enter a name for the object type in the Name field.
4. Optional: Enter a plural name for the object type, which will appear when viewing a list of
the objects for that type (e.g. “View Incidents” instead of “View Incident”).
5. Optional: Enter a description of the object type, which will appear on the Edit Object

Type page when editing the object type.

Admin: Create Object Type

Name

Incident

m

Plural Name
Incidents
Description

Records of any activities or serious incidents that occurred on or near company

property.

CANCEL « CREATE

The Create Object Type page.

6. Optional: To customize the object type monogram:

a. Click the monogram icon to the left of the Name field.
b. Enter 1 to 3 characters in the Monogram field.

c. Click the Pick a color dropdown menu to reveal the color picker. You can also

type a hex color into this field to select a color.
Customize Monogram

Monogram
|
Pick a color

HOfffF

+ DOMNE

The Customize Monogram screen.
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The monogram is used to help you quickly identify an object type
throughout CORE. If you're creating multiple similar object types (e.g.

Incidents and Incident Review) you may want to apply the same or
similar colors to their monograms to help create a theme.

d. Click Done.
7. Click Create to display Edit Object Type page.

Admin: Edit Object Type

INCIDENT

I Records of any activities or serious incidents that accurred on or near company property.

WORKFLOW

$ CONFIGURE WORKFLOW

CONCATENATIONS

£+ CONFIGURE NAME CONCATENATION

£+ CONFIGURE DESCRIPTION CONCATENATION

Overview

Summary information about the Object Type: related forms, object type groups, activities / applications, Reports, report definiti

Related Forms

Related Data Definitions

n w

A new object type. By default, new object types do not have any workflows, concatenations, or components.

Create a New Object Type Group

To create a new object type group:
Click the @ icon in the top bar > Object Type Groups in the Data Model section.
Click Create Object Type Group.

Enter a name for the object type in the Name field.

A w N

Optional: Enter a brief description of the object type group in the Long Name field, which

will appear below the object type when editing it.
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Admin: Create Object Type Group

Name

People

Long Name

These are people who are involved in an incident (witnesses, victims, suspects, etc.) and may be an
employse or visitor.

V7

The Long Name is optional and can be used in select parts of the application to provide a more detailed label to the user.

CANCEL « CREATE

The Create Object Type Group page.

5. Click Create to display the Related Object Types section.

6. In the field in the Related Object Types section, enter the name of the object type you
want to add or select it from the dropdown menu. Continue to add more object types as

needed.

Admin: Edit Object Type Group

PEOPLE

Name

People

Long Mame

These are people who are involved in an incident (witnesses, victims, suspects, etc.) and may be an
employee or visitor.

Wz

The Long Name is optional and can be used in select parts of the application to provide a more detailed label to the user.

RELATED OBIJECT TYPES

Employee Record Person .

A new Object Type Group. After clicking Create, the Related Object Types section is displayed.
7. Click Add Selected.

8. Click Done when finished.
Edit or Delete an Object Type

Overview

Administrators can edit or delete object types from your org.
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Warning:
@ If any data has been saved to or associated with an object type, it’s strongly
recommended that you do not delete it.

User Account Requirements

The user must have Administrator permissions in order to access the Admin Overview section.

Related Information/Setup
Please refer to the Object Types Overview article for more information on object types.

Please refer to the Delete an Object article to learn more about deleting objects before deleting
an object type.

Please see the Edit or Delete a State article for further information on editing an object type's
workflow.

Please refer to the Add Concatenation to an Object Type article for further information on editing
an object type's concatenation.

Navigation

1. From the Home screen, click the Administration icon.

@ (Qsearcn 000 [8le a

Home v MyTasks

My Tasks ¢ SORT v Q SEARCH

Administration Icon

2. From the Administrator Settings menu, click Admin Overview.


http://help.resolver.com/help/object-types-overview
http://help.resolver.com/help/delete-an-object
https://help.resolver.com/help/edit-or-delete-a-state
https://help.resolver.com/help/add-name-or-description-concatenations-to-an-object-type
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@ (Qsearh 80O Q
Home v T
Settings
My Tasks 4 SORT Q SEARCH 8o User Management
@ Branding

€3 Languages

Administrator Settings Menu

3. From the Admin Overview screen, click the Object Types tile under the Data Model

section.
@ (Qsearch 00 80 Q
‘Admin Overview v
Data Model Views
O ma| | il

=18 O

People Application Management
o,

Q 1) [ A

Users User Groups Roles Org Manager Applications

Object Types Tile

4. From the Admin: Object Types screen, enter a keyword in the Search field to narrow the

Object Types list.

® (Qzearch 8O 2
Data Model v Obiject Types Object Type Groups Fields Assessments Data Definition
Admin: Obiect Types
| Activity] ° |

° Activity
@ Activity Type
e Finding

Results or evidence from a specific audit activity

L Log

Single entry of related activity to an Investigation or Case, used for evidentiary purposes, including times and costs.

T Task

Actionable record for key data objects (Incident, Case, Activity) with user assignment. date tracking and email notifications

W VIEW OBJECT TYPE UNIVERSE

Search Field

5. Click the Object Type you wish to edit or delete.
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® (Qsearch B2
Data Model 4 Object Types Object Type Groups Fields Assessments Data Definition
Admin: Object Types
Activity] o

| ° Activity |
@ Activity Type
e Finding

Results or evidence from a specific audit activity

L Log

Single entry of related activity to an Investigation or Case, used for evidentiary purposes, including times and costs.

T Task

Actionable record for key data objects (Incident, Case, Activity) with user assignment. date tracking and email notifications

W VIEW OBJECT TYPE UNIVERSE

Object Type Name

Editing an Object Type
1. From the Admin: Edit Object Type screen, click the Edit icon beside the object type’s

name to edit the object type’s name, description, or monogram.

@ (Qsearen @

Data Model v ObjectTypes Object Type Groups Fields. Assessments Data Definition

S)
o

Admin : Edit Object Type
Activity

‘Workflow

Concatenations

© CONFIGURE NAME CONCATENATION

© CONFIGURE DESCRIPTION CONCATENATION

Overview Fields (18) Formulas (8) Relationships (16) Ref

ces (1) Roles (1)

Edit Object Type Icon

2. Edit the object type's Name, Plural Name, and Description by clicking on a

corresponding field and entering a new value.

® (Q search ol©)

Do

Data Model v Obiject Types Object Type Groups Fields Assessments Data Definition

Admin:Edit Object Type

Activity 4
@ *Name
Activity
o Plural Name
Activities
Description

Edit Name Fields
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3. Click on the object type's Monogram.

® (Q search. 8@ L
Data Model ~ Object Types. Object Type Groups Fields Assessments Data Definition
Admin: Edit Object Type
Activity 4
@ *Name
Activity
Plural Name
Activities
Description
4
Monogram

4. From the Customize Monogram pop-up enter a new value in the Monogram field.

® (Qsearch ORI
Data Model ~ Object Types. Object Type Groups Fields Assessments Data Definition

Admin: Edit Object Type

Activity ’

*Monogram

Act

*Pick a color
@ 006260

+ DONE

Monogram Field

5. Click the Pick a Color field and select a different color from the dropdown color picker.

@ (Qsearch IO R,
Data Model v Object Types Object Type Groups Fields Assessments Data Definition

Admin:Edit Object Type

Activity 4

@ Customize oragram

* Monogram
Act

*Pick a color
@ 005260

CURRENT COLOR

+ FAVORITE

Workflow | PALETTE

EEET EEEE
work) NI I
- AHEN EEEN
EEEE =N

v | m ]

References (1) Roles (1)
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Pick a Color Field

6. From the Workflow tab, click on the Configure Workflow button to edit the object type's

workflow. Please see the Edit or Delete a State article for further information on editing an

object type's workflow.

Do

@ (Qsearch (IO

Data Model ~ Object Types Object Type Groups Fields Assessments. Data Definition
Admin : Edit Object Type
Activity
Workflow Concatenations

Workflow

% CONFIGURE WORKFLOW

Configure Workflow Button

7. Click the Concatenations tab.

Do

® (Qsearch 8 O

Data Model v Object Types Object Type Groups Fields Assessments Data Definition
Admin: Edit Object Type

Activity

Workflow Concatenations

Workflow

X CONFIGURE WORKFLOW

Concatenations Tab

8. From the Concatenations tab, click on the Configure Name Concatenation or
Configure Description Concatenation links to edit a concatenation. Please refer to
the Add Concatenation to an Object Type article for further information on editing an object

type's concatenation.


https://help.resolver.com/help/edit-or-delete-a-state
https://help.resolver.com/help/add-name-or-description-concatenations-to-an-object-type
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Data Model

® (Qsearc

Do

v Object Types Object Type Groups Fields Assessments Data Definition

Admin: Edit Object Type

Activity

Workflow Concatenations

Concatenations

£ CONFIGURE NAME CONCATENATION
x

£ CONFIGURE DESCRIPTION CONCATENATION

x

9. Click

10. Click

an ex

Concatenation Links

the tabs to edit, add, or delete the components added to the object type.
Overview Tab: The Overview tab summarizes the related forms, object type
groups, activities, applications, reports, and report definition connected to the object
type.
Fields Tab: The Fields tab displays the fields that are connected to the object type.
The Fields tab allows you to add fields to or unlink fields from the object type.
Please refer to the Add Fields to an Object Type article for information on adding a
field to an object type.
Formulas Tab: The Formulas tab displays the formulas connected to the object
type. The Formulas tab allows you to add fields to or delete formulas from the
object type. Please refer to the Create Formulas on an Object Type article for
information on adding a formula to an object type.
Relationships Tab: The Relationships tab displays the relationships connected to
the object type. The Relationships tab allows you to add relationships to or delete
relationships from the object type. Please refer to the Create Relationships on an
Object Type article for information on adding a relationship to an object type.
References Tab: The References tab displays the object type's references
which indicates that an object is connected to another object through a relationship.
Roles Tab: The Roles tab displays the roles connected to the object type. The
Formulas tab allows you to add fields to or delete formulas from the object type.
Please refer to the Add Roles to an Object Type article for information on adding a
role to an object type.

on a Field, Formula, Relationship, or Role link (under its corresponding tab) to edit

isting object connected to the object type.


https://help.resolver.com/help/add-fields
https://help.resolver.com/help/add-formulas
https://help.resolver.com/help/add-relationships
https://help.resolver.com/help/add-roles
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® (Qsearch. S e 2
Data Model v Object Types Object Type Groups Fields Assessments Data Definition
Overview Fields (18) Formulas (9) Relationships (16) References (1) Roles (1)

All of the formulas that have been built Activity.

Activity DoW o
3 Formuia i IED_DT.0."hours") H#1)/24)+4).7) will render with a None

Activity ToD o
3 Formula mod((timediff( SUPPLIED_DT.0."hours"}+TimeZoneNDEPTH+1)-5).24) wil rencer with 2 Label

Count o
5 Formula COUNT will render with a None

Earliest Response Time o
3 Formula timeDIff(ARRIVEDDAT, ASSIGNEDDA, "minutes") wil render with 3 None

Linked Incident Count o
3 Formula IncExists will eender with a Label

On Site Time o
3 Formula timeDiff(MAXCLEAREDDATE, MINARRIVEDDAT,"minutes") il render with 3 None

Priority o
3 Formula PRIGRITY wil render with a Label

Time o
3 Formula willrender with a None

Time Spent o
3 Formula L2HoL LEAREDDAT, ender with a None

- v oonE

Formula Link

9. Click on the Delete or Unlink icon to delete or remove the corresponding object from the

object type.

® (Qsearch. e 2
Data Model ~ Object Types Object Type Groups. Fields Assessments Data Definition
Overview Fields (18) Formulas (9) Relationships (16) References (1) Roles (1)

All of the formulas that have been built Activity.

Activity DowW
% Formula tir |ED_DT,0,"hours"): 'H#1)/24)+4),7) will render with a None

Activity ToD o
3 Formuls mod({timediff{SUPPLIED_DT.0."hours)+TimeZoneNDEPTH+ 1)-5).24) wil renc

Count o
3 Formula COUNT will render with a None

Earliest Response Time o
§ Formuls timeDiff{ARRIVEDDAT, ASSIGNEDDA, "minutes") il ren

Linked Incident Count o
3 Formula Inexists wil rende

On Site Time o
3 Formula timeDIff(MAXCLEAREDDATE, MINARRIVEDDAT."minutes") o1 with 2 None

Priority o
5 Formula PRIORITY wil render with a Label

Time o
3 Formula willrender with a None

Time Spent o

3 Formuls HOURS==INULL?HOURS imeDiff( CLEAREDDAT, ASSIGNEDDA, "hours") wil render with s None.

n v ponE

Delete Icon

9. Click the Done button when you are finished.
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Data Model

@ (Qsearch

Object Type Groups Fields.

v ObjectTypes Assessments Data Definition

Gl

‘Workflow

Concatenations

© CONFIGURE NAME CONCATENATION
# CONFIGURE DESCRIPTION CONCATENATION
Overview Fields (14) Formulas (0)

Relationships (2) References (0) Roles (0)

‘Summary information about the Object Type: related forms, object type groups, activities / applications, Reports, report definitions.

Related Forms.

Related Data Definitions

Priority: none

. E=N

B0

Done Button

Deleting an Object Type

1. Before deleting an object type, you must delete all objects associated with it.

2. To delete the object type, click the Delete icon.

Data Model

@ (Qseaen

v ObjectTypes Object Type Groups Fields. Assessments Data Definition

Gl

‘Workflow

Concatenations

© CONFIGURE NAME CONCATENATION
© CONFIGURE DESCRIPTION CONCATENATION
Overview Fields (14) Formulas (0)

Relationships (2) References (0) Roles (0)

‘Summary information about the Object Type: related forms, object type groups, activities / applications, Reports, report definitions.

Related Forms.

Related Data Definitions

Priority: none

o

B0 Q

Delete Icon

3. Click the Delete button to confirm.



http://help.resolver.com/help/delete-an-object
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@ (Q sean

Data Model v ObjectTypes Object Type Groups Fields Assessments

Gl

Workflow

Concatenations

© CONFIGURE NAME CONCATENATION

© CONFIGURE DESCRIPTION CONCATENATION

Overview Fields (14) Formulas (0) Relationships (2) References (0) Roles (0)

Summary i about the Object Type: related forms, object type groups, /applications, Reports, report defintions.

Related Forms Delete object type? x

Deleting this object type will delete allitems associated
withiit

Related Data Definitions

Delete Button

Edit or Delete an Object Type Group

To edit or delete an object type group:

1.

Click the 5:@3 icon in the top bar > Object Type Groups in the Data Model section.

2. Click the object type group you want to edit to display the Edit Object Type Group page.
3.
4

. To add an additional related object type, enter the name of the object type you want to add

Enter an alternate name in the Name or Long Name fields, as needed.

or select it from the dropdown menu in the Related Object Types section, then click Add

Selected.
5. To remove a related object type, click the " icon next to that object type.
6. To delete the object type, click the [ e | icon, then click Yes to confirm.

7. Click Done when finished.
Delete an Object

Overview

Depending on their role permissions, both Administrators and users can delete objects.
However, before an object can be deleted, you must review the Deletion Request warning,
which outlines how deleting that specific object impacts other objects connected through
relationships or references.

User Account Requirements

The user must have Delete Object permissions to delete objects.

Deleting an Object

®©

Warning:
Deleting an object with relationships or references will delete that object’s connection to
those other objects, but it will not delete the other objects to which it was related.


http://help.resolver.com/help/workflow-permissions
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1. Open the object you want to delete in full screen mode.

Note:
@An object can only be deleted in full screen mode.

(Qproperty 808

Applications v

Explore:Search Results

Lost - Property AcTIVE
Current Search Parameters: Keywords: property
e Detais Histon
Filter by Activity v
Activity 2 Activity Category @ Available in Dispatch
[E¥E) ACT023: Dama
D 9 [ property v ®ves =
Activity Type. 2
et et . ACTO06: Damage  Activity Sub Category © Activity Type Abbreviation @
§ = v st
Incident s
.- Activity Type Details @
Activity Type
Incident Type s [ eneck
Involved Location 4 Lost - Property
Ivalved Person 1
Damage - Propert
Requiement 2

Full Screen Icon

2. From the object, click the More Actions icon.

CEE e

Applications v

Lost - Property

Details Relationship Graph History.

Activity Category @ Available in Dispatch

== ] [ew s

Activity Sub Category @ Activity Type Abbreviation @

[ 9 [

Activity Type Details @

]

More Actions Icon

3. Click Delete.

Q Searc [CIORPN
Applications. v
Lost - Property AcTIVE
2 EditForm Template
> Merge Dupicate
Detals Relationship Graph History

Activity Category @

==

Activity Sub Category @

[

Available in Dispatch

] [ow

Activity Type Abbreviation @

v] [

Activity Type Details @

[

Delete

4. If the Retain Data for Analytics toggle switch on the Data Retention tab is enabled for
the object type, the following Deletion Request pop-up will appear when deleting an

object. For more information, please refer to the Data Retention section.


http://help.resolver.com/5852e03f32131c1a554c0a0a/language/en/version//help/data-retention
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Deletion Request Pop-up

5. Read the warning as it will outline the number of relationships and references that will be
impacted if the object is deleted from the system.

6. (Optional): Select the Retain Data for Analytics toggle switch to turn it on to retain the
information selected on the Data Retention tab for the object type and delete all other

related data.

X CANCEL ® oeeTe

Enabled Retain Data for Analytics Toggle Switch

7. (Optional): Leave the Retain Data for Analytics toggle switch disabled to delete the

object and all related data from the system.

eletior
Please review the impact of the delete prior to the deletion

Lost - Property has 1 el

Disabled Retain Data for Analytics Toggle Switch

8. Click the Delete button. The object will go into a purge queue and cannot be reverted. It
can take up to one week to fully remove the object, and related information from the

system.
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X CANCEL ® oeeTe

Delete Button

9. If the Retain Data for Analytics toggle switch on the Data Retention tab is disabled for
the object type, the following Deletion Request pop-up will appear when deleting an

object.

Deletion Request
Please review the impact of the delete prior to the deletion

Lost - Property has 1 relationships and is referenced in 1 places.

Deletion Request Pop-up

10. Read the warning as it will outline the number of relationships and references that will be
impacted if the object is deleted from the system.

11. Click the Delete button. The object will go into a purge queue and cannot be reverted. It
can take up to one week to fully remove the object, and related information from the

system.

Delete Button



